Izrada prvog crteza

U ovoM POGLAVLIU upoznacdete neke od osnovnih funkcija programa AutoCAD. Imacete
priliku da veZzbate u grafickom editoru. Crtacete jednostavan crtez koji ¢ete koristiti u
kasnijim veZbanjima. Naucicete kako da unosite podatke u AutoCAD, da tumacite zah-
teve za unos i da u slu€aju potrebe trazite pomoc. Ovo poglavlje obuhvata i korisScenje
koordinatnog sistema koji sluZi za precizno zadavanje dimenzija objektima u Auto-
CAD-u. Videcete kako da izaberete objekte koje ste nacrtali i kako da zadate osnovne
tacke za pomeranje i kopiranje.

Ako niste pocetnik u AutoCAD-u, moZda Cete Zeleti da odmah predete na sloZenije
teme u poglavlju 3. Koristite datoteke s prateceg CD-a da biste nastavili obuku.

U ovom poglavlju su obradene sledece teme:

v Upoznavanje s paletom Draw

v Pocetak rada na prvom crtezu

v Zadavanje rastojanja pomocu koordinata
v Kursori razli¢itih oblika i zahtevi za unos
v Izbor objekata

v Pomoc¢ tokom rada

v Ako Zelite da eksperimentisete...

Upoznavanje s paletom Draw

Prvi zadatak tokom obucavanja za crtanje u AutoCAD-u jeste da nacrtate liniju (duZ).
Pre nego Sto pocCnete crtati, zadrzacemo se za trenutak na paleti alatki koja se koristi vise
od svih ostalih — paleti Draw:

1. Pokrenite AutoCAD kao §to ste radili u prvom poglavlju - pritisnite Start > All Pro-
grams > Autodesk > AutoCAD 2005 > AutoCAD 2005. Ako se otvori okvir za dija-
log Startup, pritisnite Cancel i podrazumevano ce se otvoriti dokument Drawing]1.
Kasnije u ovom poglavlju naucicete viSe o ovom okviru za dijalog.
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2. U prozoru AutoCAD postavite kursor na ikonicu na vrhu palete Draw (to je verti-
kalna paleta uz levu ivicu prozora AutoCAD) i zadrZzite ga na tom mestu dok se ne
pojavi ime alatke.

3. Polako pomerajte kursor nadole preko ostalih alatki palete Draw i procitajte
kratak opis svake od njih.

U vecini slucajeva prepoznacete funkciju svake alatke vec¢ po izgledu njene ikonice.
Slicica lika, recimo, govori da se alatka koristi za crtanje lukova; sli¢ica elipse govori da
alatka sluzi za crtanje elipsa itd. Simo ime alatke bolje ¢e objasniti njenu funkciju. Osim
toga, statusna traka na dnu prozora AutoCAD daje obavesStenja o alatkama. Na primer, ako
pokazete alatku Multiline Text na dnu palete Draw, na statusnoj traci moci cete da proci-
tate objaSnjenje Creates a multiple-line text object (Pravi okvir za unos viSered-
nog teksta). Ovo vam takode govoriime komande: MTEXT. UpiSite ime komande: MTEXT u
komandni prozor, ako vam se viSe dopada da tako pokrenete ovu alatku nego pritiskom
ikonice na paleti alatki. Ukoliko piSete makro ili pravite svoje alatke, koristite MTEXT.

> &

Model 4 Lay:
Multiling Text

HAutDCAD Express Tools Cop

AutoCAD menu utilities loc

Connand :

Creates a multiple-line text object: MTEXT

Tabela 2.1 pomoci ¢e vam u radu s dve osnovne palete, Draw i Modify. Tokom ucenja
uz ovu knjigu, imacete priliku da isprobate mnoge AutoCAD-ove alatke.

Tabela 2.1: ALATKE S PALETA DRAW | MODIFY | NJIHOVE POTPALETE
PALETA DRAW PALETA MODIFY
IKONICA ALATKA IKONICA ALATKA

Line — linija (du2) Erase - brisanje

Construction Line (Xline) — prava Copy Object - kopiranje objekata

Polyline (Pline) — sloZena linija
(polilinija)

Mirror — preslikavanje

Polygon - poligon Offset — paralelno kopiranje

objekata

Rectangle — pravougaonik Array — viSestruko kopiranje

objekata (matrica)

Arc - |dk Move - translatorno pomeranje
objekata
Circle - krug Rotate - rotiranje objekata
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UPOZNAVANIJE S PALETOM DRAW

Tabela 2.1: ALATKE S PALETA DRAW | MODIFY | NJIHOVE POTPALETE (NASTAVAK)
PALETA DRAW PALETA MODIFY

IKONICA ALATKA IKONICA ALATKA

Scale - linearno uvecanje

Q Revcloud - zatvorena sloZzena
ili umanjenje objekata

linija sastavljena od jednakih lu¢nih
segmenata koji formiraju oblak

(]

Spline — sloZena linija tipa spline
(krive viseg reda)

Stretch - istezanje objekata

Ellipse - elipsa Trim — odsecanje objekata

Ellipse Arc- elipti¢ni Ik (prvi put u
verziji 2000)

Insert Block — umetanje blokova

Extend — produZavanje objekata

Break At Point — prekidanje
objekata u zadatoj tacki

Make Block - pravljenje blokova Break - prekidanje objekata

Point - tacka Chamfer - obaranje ivica
Hatch - Srafura Fillet — zaobljavanje ivica

Region - oblast
Table - tabela

Explode - rastavljanje sloZenih
objekata

ﬂ
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Multiline Text — viSeredni tekst
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Kao $to ste naucili u poglavlju 1, pritiskanjem ikonice alatke aktivirate komandu.
Neke alatke moZete izabrati i vudi, ¢ime otvarate potpaletu na kojoj se nalaze dodatne
opcije te alatke. Ako alatka ima potpaletu, videcete mali trougao u donjem desnom uglu
ikonice alatke.

Sada éete malo provezbati kori§éenje potpaleta:

1. Pritisnite i povucite alatku Zoom Window, koja se nalazi na paleti Standard. Poja-
vljuje se potpaleta s nizom dodatnih alatki. Te alatke omogucavaju da podesite
prikaz na razli¢ite nacine.

= Draw Dimepsion Modify Window Help
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2. Pomerajte kursor niz potpaletu ka poslednjoj alatki sve dok ne vidite natpis Zoom
Extents, a zatim otpustite taster miSa. Umesto ikonice alatke Zoom Window sada
je tu ikonica koja predstavlja komandu Zoom Extents.

Lraw  Dimension  Modify  Window  Help
7| LXQRHER I @
B e

Pritiskanjem ikonice alatke Zoom Extents aktivirate istoimenu komandu koja
podesava prikaz tako da elementi crteza ispune prostor za crtanje. Posto crtez
sada ne sadrZi nijedan element, prikaz se nece promeniti. U poglavlju 3 upotre-
bicete ovu komandu Zoom Extents i videti kako ona deluje na elemente crteza.

3. Da bi alatka Zoom Window ostala vidljiva na paleti Standard, pritisnite i povucite
ikonicu alatke Zoom Extents, a zatim izaberite ikonicu alatke Zoom Window, koja
se nalazi na vrhu potpalete. Pritisnite taster Esc da biste prekinuli komandu Zoom
Window (koju cete koristiti u poglavlju 3).

AutoCAD omogucava brz pristup najcesce koris¢enim komandama s potpaleta tako

§to poslednju izabranu opciju smatra podrazumevanom. Ta osobina moZe da zbuni
pocetnike u AutoCAD-u. Isto tako, grupisanje opcija u potpaleti nije uvek samo po sebi
razumljivo, ¢ak ni iskusnima u radu sa AutoCAD-om.

SAVET  Ako se ispostavi da cesée radite s nekom potpaletom, lako je moZete pretvoriti u
plutajucu paletu alatki da bi vam bila dostupna cim jednom pritisnete taster misa. Na primer,
potpaletu Zoom, koju ste malopre koristili, moZete otvoriti kao paletu alatki tako Sto cete
desnim tasterom misa pritisnuti bilo koju paletu alatki, a zatim iz prirucnog menija koji se
pojavi izabrati Zoom.

RAD S PALETAMA ALATKI

U sklopu vezbi iz knjige pokazacu vam graficke simbole alatki koje treba da izaberete, te
paletu i potpaletu koje sadrZe tu alatku. Nemojte se brinuti ako paleta alatki iz primera ne
izgleda isto kao paleta koju vidite na ekranu. Radi Stednje prostora na stranama, na nekim
mestima su slike paleta i potpaleta postavljene horizontalno; one koje vidite na ekranu mogu
biti postavljene vertikalno, poput paleta Draw i Modify, koje se nalaze na levoj, odnosno des-
noj strani prozora AutoCAD. Bez obzira na razli¢it oblik paleta i potpaleta na ekranu i u
knjizi, njihov sadrzZaj je isti. Kada posmatrate graficki znak koji predstavlja alatku, vazno je da
obratite paZnju na samu ikonicu sa imenom alatke i na paletu u kojoj se ta alatka nalazi.

Pocetak rada na prvom crtezu

U poglavlju 1 videli ste uzorak crteza koji ste dobili uz AutoCAD. Samostalan rad
pocecete crtanjem vrata koja ce se koristiti i u kasnijim vezbama. Prvo morate nauciti
kako da saopstite AutoCAD-u ono $§to Zelite i, §to je vaznije, morate razumeti $ta Auto-
CAD trazi od vas.
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SAVET U ovom poglavlju videcete uputstva i za britanski i za metricki sistem. Uglavnom ce
prvo biti data uputstva za britanski sistem, a posle njih i za metricki. Medutim, jos se necete
baviti inc¢ima i centimetrima. Zasad se samo upoznajete sa sistemom AutoCAD-a.

Pocnite tako §to Cete otvoriti okvir za dijalog Create New Drawing. Ovaj okvir za dija-
log pomodi ée pocetniku pri brzom podesavanju crteza.

1.

2.
3.

4.

Izaberite Tools > Options. Otvorice se okvir za dijalog Options.
2
Currert piofile: <cUnnamed Profile>> Cunent drawing Diawingl.dwg
Fies | Disslay | Open and Save | Plot and Publish Svstem | User Preferences | Diafing | Selestion | Profles |
Current 3D Graphics Display General Options
’7 GSHEIDND - s I™ Single-drawing compalibiity made
[V Display OLE properties dialog

Cumert Pointing Deviee ——————————— I Show &l warring messages

[~ Beep on emor in user input

[ Curent System Pointing Device =l Ty ———
Accept input from: [V Allow lang symbol names

€ Digiizeoril

SHEEAL) Statup:  [Do nol show a startup dialng 2
@ Digitizer andimause o g
Do not show a startup dialog
[ Loyt Regen Optons | [ Live Enabler Uption ‘

' Regen when suitching layouts

I Check Web for Live Enablers

Pritisnite jezi¢ak kartice System.

U grupi opcija General Options, pritisnite padajucu listu Startup i izaberite Show
Startup Dialog Box.

Pritisnite OK da biste potvrdili nov parametar i izadite iz okvira za dijalog.

Biranjem opcije Show Startup Dialog Box, AutoCAD ¢e otvoriti okvir za dijalog Create
New Drawing kad god budete pocinjali nov crtez. Ovaj okvir za dijalog koristicete na
pocetku poglavlja. Ako odlucite da vam ne treba ¢arobnjak, posto ste se bolje upoznali
sa AutoCAD-om, lako ga mozZete iskljuciti ponavljajuci prethodne korake. Umesto da
izaberete Show Startup Dialog Box u koraku 3, izaberite Do Not Show A Startup Dialog.

NAPOMENA  Kada je ukljucena opcija Show Startup Dialog Box, okvir za dijalog Startup ce

se prikazivati i pri pokretanju AutoCAD-a. Okvir za dijalog Startup je vrlo slican okviru New
Drawing.

Napravimo sada novu datoteku.

1.

Izaberite File > Close da biste zatvorili tekucu datoteku. U okviru za dijalog Save
Changes izaberite No. Palete alatki nestaju i pojavljuje se AutoCAD-ov prozor za
crtanje koji je prazan, jer nijedan crteZ nije otvoren.

Izaberite File > New da biste otvorili okvir za dijalog Create New Drawing.

[#: Create New Drawing 2lx|

@”E @ Start from Scratch

- Default Satting

& Hrnperial fest and inchest

 Metic

Tip
Uses the default imperial f=st and inches) sttings

Carcel
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3. Pritisnite dugme Use A Wizard (sli¢ica papira s podvijenim vrhom i ¢arobnim
Stapic¢em). U polju s listom Select a Wizard pojavljuju se dve nove opcije: Advan-
ced Setup i Quick Setup.

[% Create New Drawing 2lx

QIJJI"— Use a Wizard

Select a wizard

Advanced Seluﬁ F

W\zard Description
Sets the units and area far your new draving. Based on the template acad.dwt

4. Izaberite opciju Quick Setup, a zatim pritisnite OK. Pojavljuje se okvir za dijalog
Quick Setup Units.

» Units Select the unit of measurement.

Area

. Engineering
. 15,5000
 frchitectural

' Fractional

 Seientific

< Back I Nexst > I Cancel |

5. Zasad Cete koristiti standardne decimalne jedinice, kao $to je i naznaceno izab-
ranim radio-dugmetom. O ovim opcijama bice viSe reci u slede¢em poglavlju.
Pritisnite Next i pojavljuje se okvir za dijalog Quick Setup Area.

6. Ako u polju Width nije ve¢ upisan broj 12, upisite ga. Oni koji koriste metricki
sistem trebalo bi da unesu 40.

N

Pritisnite taster Tab da biste presli u polje za unos Length i upisite 9. Oni koji kori-
ste metricki sistem trebalo bi da unesu 30.

Izaberite Finish. U AutoCAD-ovom prozoru pojavljuje se nova datoteka.

®
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QuickSetup x|
. Enter the area pou want to represent using full scale
Units uritz. Example: to diaw in an area 12 » 9 meters, enter
12 under ‘Width and 3 under Length.
b Area

Length:

12.0000

< Back I Finizh I Cancel |

9. Izaberite View > Zoom > All s linije menija. Na taj nacin ¢ete zadati da prikaz
zauzme celokupan prostor koji ste definisali u koracima 61i 7.
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10. Izaberite File > Save As da biste svojoj novoj datoteci dali jedinstveno ime. Otvo-
rice se okvir za dijalog Save Drawing As.

11. Otkucajte Vrata. Dok kucate, ime se pojavljuje u polju File Name.

12. Dvaput pritisnite direktorijum Sample s glavne liste datoteka u okviru za dijalog
da biste otvorili poddirektorijum Sample.

13. Izaberite Save. Sada imate datoteku Vrata. dwg, koja se nalazi u poddirektori-
jumu Sample direktorijuma AutoCAD2005. Datoteka je jo§ prazna. Popunja-
vanjem Cete se baviti kasnije.

Kada otvorite novu datoteku, pred vama se na ekranu nalazi povrsina za crtanje, Siroka
otprilike 12 in¢a i visoka oko 9 in¢a (40 x 30mm, u metrickom sistemu). To je vasa radna
povrsina, mada niste ograniceni samo na nju. Nikakvi vidljivi podaci ne odreduju veli¢inu
te povrSine. Tacne dimenzije saznacete ako pomerite kursor do gornjeg desnog ugla
ekrana i procitate vrednost koja se pojavljuje u polju koordinata, u donjem levom uglu
prozora programa AutoCAD. To je standardna povrs§ina AutoCAD-a za izradu novih crteZa.
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SAVET
komande. Na primer, komandu Line zadajete i ako upisete LO] u komandnom prozoru.

UPOZORENJE  Pokazivac koordinata nece pokazivati tacno 12 x 9 inca, odnosno 40 x 30
mm, zato §to proporcije povrsine za crtanje najverovatnije ne iznose tacno 12 X 9 ili 40 x 30.
Kada izaberete View > Zoom > All, AutoCAD ce pokusati da prilagodi prikaz vasoj povrsini za
crtanje.

File Edt Wew Insert Format Tools Draw Dimension Modfy Window Help
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Pratite sledece korake da biste zapoceli crtez:

1. Izaberite alatku Line s palete Draw ili otkucajte L.

Upravo ste zadali komandu Line. AutoCAD na to odgovara na dva nacina. Prvo
¢ete u komandnom prozoru ugledati poruku:

Specify first point: (zadajte prvu tacku)

koja trazi da izaberete pocetnu tacku linije. Kursor je promenio oblik; krsti¢ vise
nema kvadrati¢ u centru. Na osnovu toga znate da treba izabrati jednu tacku za
pocetak linije.

Radeci veZbe iz ove knjige, moci Cete da koristite i precice s tastature da biste zadali

2. Levim tasterom mi$a izaberite tacku u blizini centra ekrana. Naredna poruka

glasi:

Specify next point or [Undo]: (zadajte sledeéu taCku ili [Poni$-
titel])

Dok pomerate kursor, prati ga linija koja je drugim krajem ucvr§éena za odabranu

tacku (gornji crteZ na slici 2.1). Takve linije nazivamo rastegljive (engl. rubber-
banding).
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SLIKA 2.1
Rastegljiva linija.

Prva tacka

’»

Rastegljiva linija

Rastegljiva linija

Y Segment linije
I—o_ X

3. Ako kursor pomerite levo ili desno od poloZzaja koji je u visini izabrane tacke, uz
kursor ce se pojaviti horizontalna tackasta linija i poruka koja daje savet o alat-
kama. Isto se dogada i kada kursor pomerite vertikalno iznad ili ispod izabrane
tacke. U stvari, izgledace kao da kursor skace u horizontalan ili vertikalan polozaj.

Polar: 3.0106 < 0°

Opisana osobina se naziva pracenje po polarnim koordinatama (engl. polar trac-
king). Ta opcija pomaZe da liniju nacrtate tacno u horizontalnom ili vertikalnom
pravcu, kao kad crtate pomocu T-lenjira i trougla. MoZete da je ukljucite ili isklju-
Cite tako Sto Cete pritisnuti dugme Polar na statusnoj traci. Ako je ne vidite, najve-
rovatnije je iskljuc¢ena. O ovoj opciji bice vise reci u poglavlju 3.
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4. Nastavimo rad s komandom Line.

Pomerite kursor do neke tacke ispod i desno od prve tacke koju ste izabrali i
ponovo pritisnite levi taster miSa. Prva rastegljiva linija sada je pricvrS¢ena
izmedu dve tacke koje ste izabrali i pojavljuje se druga rastegljiva linija (drugi
crtez na slici 2.1).

5. Liniju neodgovarajuce duzine mozete promeniti dok je komanda Line aktivna.
Izaberite Undo s palete Standard ili upi$ite UC. Linija koju ste prethodno nacrtali
postaje ponovo rastegljiva, kao da uopste niste bili izabrali drugu tacku i fiksirali
njenu duZzinu.

SAVET  Alatka Undo s palete Standard nudi padajucu listu Undo sa koje moZete izabrati
tacno onu komandu koju treba izbrisati. Pogledajte izdvojeni odeljak koji sledi, Kako da se
izvucete iz nevolje.

Upravo ste nacrtali i obrisali liniju proizvoljne duZine. Komanda Line je jo§ uvek
aktivna. To potvrduju dva pokazatelja: ne vidite re¢ Command na dnu komandnog pro-
zora, a kursor je obic¢an krsti¢ bez malog kvadrata u centru.

SAVET  Od sada éemo krsti¢ bez kvadratica zvati kursor za izbor tacaka (engl. point selec-
tion mode of the cursor). Na slici 2.7 videcete razlicite oblike kursora za crtanje.

KAKO DA SE 1ZVUCETE 1Z NEVOLJE

| pocetnici i iskusni korisnici ponekad gre3e. Pre nego $to nacnemo ozbiljnije teme, nabro-
ja¢emo nekoliko moc¢nih alatki koje ¢e vam pomodi ako se nadete u nevolji.

Backspace () Ako pogresite pri kucanju, tasterom Backspace obrisite gresku i ponovo
upisite komandu ili odgovor. Ovaj taster se nalazi u gornjem desnom uglu osnovnog dela
tastature.

Escape (Esc) Ovo je verovatno najvazniji taster na tastaturi. Kada treba brzo, bez ika-
kvih izmena izadi iz komande ili iz okvira za dijalog, pritisnite taster Esc u gornjem levom
uglu tastature. Pre AutoCAD-a 2000, u nekim slucajevima trebalo je dvaput pritisnuti
taster Esc. U novijim verzijama dovoljno je pritisnuti Esc samo jedanput, a nece biti Stete
ni ako ga pritisnete dvaput. (Pritisnite taster Esc pre nego Sto pocnete da menjate crtez

koristeci ¢vorove (engl. grips) ili da zadajete komande preko tastature.)

U Ako slucajno izmenite deo crteZa pa hocete to da ponistite, pritisnite alatku Undo s
palete Standard (ikonica sa strelicom savijenom ulevo). Isto tako, U moZete upisati i u
komandni prozor. Kad god to uradite, AutoCAD ponistava jednu po jednu operaciju i to
redosledom obrnutim od onog kojim ste ih izveli — poslednja zadata komanda ponistava
se prva, zatim pretposlednja itd. U komandnom prozoru se pojavljuje ime komande koja
se ponistava, a crteZu se vraca izgled koji je imao pre primene komande. Tako moZete
ponistiti sve Sto ste izmenili i crteZu vratiti izgled s pocetka radne sesije.

Undo Ako odlucite da se vratite nekoliko koraka od operacije koju ste upravo izveli,
mozZete upotrebiti alatku Undo (strelica savijena ulevo) s palete Standard ili otkucajte
Undo[. Svaki put kada pritisnete alatku Undo, vracate se jednu operaciju unazad. Isto
tako, moZete tacno izabrati komandu koju Zelite da izbriSete koristeci padajucu listu
Undo. Ovu listu moZete otvoriti pritiskanjem strelice nadole, koja se nalazi desno od
alatke Undo.
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Tools -Draw Dimension  Modify  Window Help
%=Bo /) (€A BRERID G
| ||

[ Undo 1 command

Redo Ako komandom Undo slucajno ponistite previSe prethodnih radnji, poslednju
ponistenu komandu moZete vratiti pomocu alatke Redo (strelica savijena udesno) sa
palete Standard; ili upisite Redod. U AutoCAD-u 2005, Redo omogucava da vratite neko-
liko operacija koje ste mogli da izbriSete komandom Undo. Isto tako, moZete izabrati
tacno onu komandu koju hocete da vratite koristeci padajucu listu Redo. Da biste otvorili
ovu listu, pritisnite strelicu nadole koja se nalazi desno od alatke Redo.

l= Draw Dimension Modify Window Help
<R /(LY XX BERID (@A
Copy obiect jv ||

Scale
Break. at point

[ Redo 1 command

Zadavanje rastojanja pomocu koordinata

Nastavicemo rad s komandom Line i nacrtati ortogonalnu projekciju (pogled odozgo)
vrata proizvoljnih dimenzija. Kasnije ¢ete crtezu zadati prave dimenzije, potrebne za
naredne vezbe. Neka duzina vrata bude 3.0 jedinice, a debljina 0.15 jedinica. U metric-
kom sistemu mera, duzina vrata bice 9 jedinica, a debljina 0.5 jedinica. Da biste preci-
zno zadali ove mere, u AutoCAD-u mozete koristiti relativni polarni ili relativni Dekartov
koordinatni sistem.

UPOZORENJE U vezbama u ovom poglavlju vrednosti britanskih i metrickih jedinica nisu
ekvivalentne. Na primer, 3 jedinice na crtezu radenom u britanskom sistemu mera nije isto $to
i 9 jedinica u metrickom sistemu. Te vrednosti su proizvoljne, a koje ce biti zadate zavisi od
toga kako ce izgledati na slikama u ovom poglavlju.

Zadavanje polarnih koordinata

Da biste nacrtali liniju duZine tri jedinice (odnosno, 9 u metrickom sistemu) nadesno od
poslednje zadate tacke, uradite sledece:

1. Otkucajte @3<0. Oni koji koriste metricki sistem neka upisu @9<0. Dok kucate,
slova se pojavljuju u komandnom prozoru.

2. Pritisnite O. Pojavljuje se linija koja pocinje od prve odabrane tacke i zavrSava se
tri jedinice dalje udesno (slika 2.2). Upravo ste zadali relativne koordinate u polar-
nom koordinatnom sistemu.
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SLIKA 2.2
Rastegljive liniije
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jo$ linijskih seg-
menata. \ -
Rastegljiva
linija

Segment linije
dug 3 jedinice,
! odnosno 9 jedinica

u metriCkom sistemu
%

Znak ,et“ (@) obavesStava AutoCAD da se rastojanje koje ste naveli racuna relativno
od poslednje izabrane tacke. Broj 3 (ili 9 u metrickom sistemu) oznacava duzinu, a znak
»manje od“ (<) obavestava AutoCAD o uglu pod kojim crtate liniju. Poslednji broj je
veli¢ina ugla, u ovom sluc¢aju 0. Na taj nacin AutoCAD-u saopStavate duZinu i smer linije
u relativnom polarnom koordinatnom sistemu.

SAVET  Ako ste navikli da na neki drugi nacin oznacavate nulti smer, AutoCAD moZzete pri-
lagoditi tako da koristi vertikalni smer ili smer nadole za nulti. Detalje potraZite u poglavlju 3.

Uglovi su dati kao $to je prikazano na slici 2.3, gde 0 stepeni oznacava horizontalan
smer sleva nadesno, 90 stepeni je pravo nagore, 180 stepeni je horizontala zdesna
nalevo itd. MoZete da zadate stepene, minute i sekunde ltika ako je takva preciznost
potrebna. Formate jedinica za uglove obradi¢emo detaljnije u poglavlju 3.

o

SLIKA 2.3 90
AutoCAD-ov
standardni sistem 135° o
za definisanje b
uglova.
180° 0°
225° 315°

270°



ZADAVANJE RASTOJANJA POMOCU KOORDINATA

Zadavanje relativnih Dekartovih koordinata
Nacrtajmo sledecu liniju pomocu druge metode preciznog definisanja duzine.

1. UpiSite @0,0.1501. Za metricki sistem, upisite @0,0.501. Pojavljuje se kratka linija
iznad krajnje tacke prethodne linije. Kao i malopre, znak @ obavestava AutoCAD
da se navedena duZina meri relativno u odnosu na poslednju tacku. U ovom pri-
meru duzinu zadajemo kao x iy vrednosti. Zadata je prvo vrednost duzine za x, 0,
odvojena zarezom, a zatim vrednost duZine za y, 0.15. Na taj nacin se definiSu
duZine u relativnom Dekartovom koordinatnom sistemu.

SAVET  Prvim korakom je naznaceno da bi oni koji koriste metricki sistem mera trebalo da
unesu @0,0.50 za duZinu. MoZete uneti i 0,.5. Nula na prvom mestu stoji radi jasnoce. Oni koji
koriste evropski metricki sistem trebalo bi da znaju da se zarez koristi da razdvoji x i y koordi-
natu. Zarez se ne upotrebljava za decimale. U AutoCAD-u se decimale razdvajaju tackom.

2. Upisite @-3,00 (@-9,00)). Duzina je takode iskazana vrednostima XY, ali ovde ste
koristili negativnu vrednost za zadavanje duzine X. Rezultat je crtez kao na slici 2.4.

SLIKA 2.4

Ove tri strane
vrata nacrtane
su alatkom Line.
Tacke su zadate }»
pomocu relativ-

nih Dekartovih
koordinata, ili

relativnih polar-
nih koordinata.

Rastegljiva linija

.

Pozitivne vrednosti u Dekartovom koordinatnom sistemu odreduju pravac linije
sleva nadesno i odozdo nagore (slika 2.5). (Ovog se moZda secate sa ¢asova geo-
metrije iz srednje 8kole!) Ukoliko Zelite da nacrtate liniju zdesna nalevo, morate
uneti negativan predznak. Takode je korisno znati gde se nalazi pocetna tacka na
crteZzu. Na novom crteZu, pocetak, tj. koordinata 0,0, nalazi se u donjem levom
uglu crteza.

SAVET  Crtanje niza linija mozete zavrsiti, a da ne zatvorite konturu; pritisnite Esc, O ili
razmaknicu (taster za razmak).

3. Otkucajte CO. C oznacava opciju Close kojom se zatvara niz linija. Nacrtali ste
liniju koja povezuje prvu i poslednju tacku niza linija i zavrsili crtanje komandom
Line (slika 2.6). Nestaje i rastegljiva linija, §to govori da je AutoCAD zavr$io crtanje
linija. Rastegljivom linijom moZete zadati smer, dok u isto vreme unosite rasto-
janje preko tastature. Pogledajte sledeci izdvojeni odeljak.
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SLIKA 2.5
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NACIN ZA BRZO UNOSENJE RASTOJANJA

Treci nacin na koji moZete uneti rastojanje jeste da pokaZete smer rastegljivom linijom, a
zatim upiSete rastojanje preko tastature. Na primer, da biste nacrtali liniju dugu 3 jedinice
sleva nadesno, izaberite alatku Line s palete Draw. Nakon toga izaberite pocetnu tacku i kur-
sor pomerite nadesno za proizvoljnu duzinu. DrZite kursor i dalje u Zeljenom smeru, a zatim
otkucajte 30. Rastegljiva linija postaje fiksirana linija duzine 3 jedinice.

Objekte odredenih duZina brzo cete nacrtati koriste¢i ovu metodu, nazvanu metoda
direktnog rastojanja (engl. Direct Distance method), u rezimima rada Ortho (ortogonalni
rezim rada) ili Polar Snap koji su opisani u poglavlju 3. Kada treba da unesete rastojanja pod
uglovima koji nisu horizontalni, ili vertikalni, koristite standardni Dekartov ili polarni koordi-
natni sistem.

UKLANJANJE NEPOTREBNIH MARKERA SA EKRANA

U nekim situacijama, AutoCAD-ov parametar Blipmode moZe biti uklju¢en i tada se na
mestima na kojima ste izabrali tacke pojavljuju mali markeri u obliku krsta (engl. blips). Ti
markeri pokazuju gde se na ekranu nalaze tacke koje ste izabrali.
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Markeri nisu deo crteZa i nece se pojaviti kada crtez Stampate, ali mogu da smetaju. Da
biste uklonili markere sa ekrana, otkucajte RO. Na ekranu ostaje samo crteZ, bez markera.
Isto Cete postici i ako izaberete View > Redraw View. Kao $to cete kasnije videti, ova alatka
moze ukloniti i neke druge probleme koji se pojavljuju na ekranu.

Marker se moZe ukloniti sa ekrana i komandom Regen, samo $to ona uz to aZurira i bazu
podataka crteZa - §to znadi da brisanje nepotrebnih elemenata sa ekrana traje duze. Ova
komanda se koristi za aZuriranje odredenih promena na crtezu. Pozabavi¢emo se njome u
poglavlju 6.

Da biste ukljucili ili iskljucili reZim rada Blip, u komandnom prozoru otkucajte blipmo-
del], a zatim on[], ili offC.

Kursori razlicitih oblika i zahtevi za unos

Da bi se uspesno radilo u AutoCAD-u, klju¢no je razumeti nacin uzajamne komunika-
cije. U ovom odeljku saznacete kako AutoCAD trazi odredene podatke ili informacije.
Kada shvatite format poruka u komandnom prozoru i prepoznate druge dogadaje na
ekranu, lakse cete nauciti program.

Kao §to poruka u komandnom prozoru pomaze recima, tako kursor pomaze vizu-
elno. Na slici 2.7 prikazani su razli€iti oblici kursora i dat je kratak opis uloge svakog od
njih. Proucite tu sliku.

SLIKA 2.7 Standardni k
T P —_—
Razliciti oblici andardni kursor
kursora.
Kursor za
izbor tacaka
Kursor za o

izbor objekata

Marker Osnap s}
sa opisom alatke
E ndpoint

Vektor za praéenje
§ pokazivatem koordinata N S

Folar: 1.91753 <07

Standardni kursor saops$tava da program ceka vas nalog. Kada vidite taj kursor,
moZete menjati objekte koristeci cvorove (engl. grips). Cvorovi su kvadrati koji se poja-
vljuju u tackama na krajevima ili u sredini objekata kada su izabrani. (MoZda ih prepo-
znajete kao markere iz nekih drugih grafickih programa.)

Kursor za izbor tacaka (engl. Point Selection cursor) pojavljuje se svaki put kada
AutoCAD ocekuje da izaberete tacku, a moZze se pojaviti i zajedno s rastegljivom linijom.
Tada tacku mozete izabrati miSem ili tako Sto cete preko tastature uneti koordinatu.
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Kursor za izbor objekata (engl. Object Selection cursor) govori da morate izabrati
objekat — miSem ili pomocu opcije za izbor objekata.

Opcija Osnap (engl. object snap), kao i kursor za izbor tacaka, pojavljuje se kada ste u
rezimu rada Osnap. Tada moZete precizno izabrati karakteristicnu tacku na objektu, kao
§to su tacke na krajevima ili u sredini objekta.

Vektor pracenja (engl. tracking vector) pojavljuje se kada upotrebite opcije Polar Trac-
king ili Object Snap Tracking. Opcija Polar Tracking pomaZe pri crtanju ortogonalnih
linija, a opcija Object Snap Tracking pomaze da poravnate tacke u prostoru u odnosu na
geometriju postojecih objekata. Opcija Object Snap Tracking radi u sprezi sa opcijom
Osnap. O vektorskom pracenju bice viSe reci u poglavljima 3 i 4.

SAVET  Ako ste iskusan korisnik AutoCAD-a i viSe volite krsti¢ koji prelazi preko celog
ekrana, izaberite Tools > Options. Otvorice se okvir za dijalog Options, pa pritisnite karticu
Display. Postavite vrednost opcije Crosshair Size, levo u donjem delu okvira za dijalog, na vred-
nost 100 i kursor Ce izgledati kao u prethodnim verzijama AutoCAD-a. Kao Sto vam opcija
govori, veli¢inu kursora moZete podesiti na bilo koji procenat ekrana. Uobicajeno je 5%.

Izbor komandnih opcija

Mnoge komande u AutoCAD-u imaju nekoliko opcija o kojima vas program obaveStava
prikazujudi njihova imena u komandnom prozoru u formatu zahteva za unos. U veZzbi
kojom to ilustrujemo, koristicete komandu Arc.

U crteZima u ortogonalnoj projekciji u SAD, lik se obi¢no crta da bi se oznacio smer
otvaranja vrata. Na slici 2.8 prikazani su jo$ neki standardni simboli koji se obi¢no kori-
ste u arhitektonskim crteZima. Ovo je deo simbola koji se nalaze na prateCem CD-u.

Sada dodajmo lik malopredasnjem crtezu vrata.

1. Izaberite alatku Arc s palete Draw. Pojavljuje se poruka Specify start point
of arc or [Center]: (Zadajte pocetnu tacku ltika ili [centar]), a kursor postaje
kursor za izbor tacaka.

Ispitajmo zahtev za unos Specify start point of arc or [Center]:.
Podrazumevana opcija (engl. default) navedena je u glavnom delu zahteva za
unos. U ovom sluc¢aju, podrazumevana je ona opcija kojom se zadaje pocetna
tacka ltka. Ako postoje jos neke opcije, one se pojavljuju u zagradama. Kada iza-
berete komandu Arc, vidite re¢ Center u zagradama, $to govori da lik mozete
poceti i tako $to Cete izabrati centralnu tacku umesto pocetne. Ako postoji vise
opcija, one se pojavljuju u zagradama i odvojene su kosom crtom (/). Ukoliko
izricito ne zahtevate neku opciju, AutoCAD nudi onu opciju za koju pretpostavlja
da cete je koristiti.

2. UpiSite C da biste izabrali opciju Center. Pojavljuje se zahtev za unos Specify
center point of arc:. Upisaliste samo C, a ne re¢ Center.

SAVET  Kada se u komandnom prozoru pojavi skup opcija, obratite paznju na velika slova.
Ako na zahteve za unos odgovarate preko tastature, kada zadajete opciju samo upisite velika
slova. Ukoliko vise opcija pocinje istim slovom, velikim slovom se pisu prva dva slova da bi se
napravila jasna razlika izmedu opcija. Takav je slucaj s komandama LAyer i LType.

3. Sada izaberite tacku koja predstavlja centar lika, kod gornjeg levog ugla vrata
(crtez 1 naslici 2.9). Pojavljuje se zahtev za unos Specify start point of
arc: (Zadajte pocetnu tacku lika).
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4. UpiSite @3<0. Korisnici metrickog sistema treba da upisu @9<0. Pojavljuje se

zahtev za unos Specify end point of arc or [Angle/chord Length]:
(Zadajte krajnju tacku liika ili [ugao/duzinu tetive]).

. Pomerite mi$a i pojavljuje se privremeni ltik koji polazi iz tacke udaljene 3 jedi-

nice nadesno od centralne tacke koju ste izabrali i rotira oko tog centra, kao na
gornjem crtezu slike 2.9. (Korisnici metrickog sistema videée privremeni ltik koji
polazi iz tacke udaljene 9 jedinica nadesno od centralne tacke.)

Kako poruka u zahtevu za unos pokazuje, na raspolaganju su vam tri opcije.
MozZete zadati ugao, duZinu tetive ili tacku na kojoj se liik zavr§ava. Ponudeni
parametar je krajnja tacka lika. Kursor je promenio oblik u kursor za izbor tacaka,
a to znaci da program ocekuje da zadate tacku. Ako se opredelite za ovu opciju,
samo izaberite tacku na ekranu i tako pokazite gde liik treba da se zavrsi.

. Kursor pomerite tako da pokazuje tacke u pravcu vertikalno od centra lika.

Videcete kako vektor Polar Tracking prelazi u vertikalan polozaj.

Polar; 2.0546 < 907
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7. Pritisnite levi taster miSa i zadajte krajnju tacku luka. Lik je sada fiksiran na
mestu, kao na tre¢em crtezu slike 2.9.

SLIKA 2.9
Koriséenje
komande Arc.

/JT:

Zadajte mesto
centra liika

-~ Pocetna tacka loka

Krajnja tacka lika ‘ \

U upravo zavrsenoj vezbi naucili ste da radite sa zahtevima za unos preko komand-
nog prozora i unosom komandi preko tastature — §to su neophodne vestine za rad sa
sloZenijim funkcijama programa AutoCAD.
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AutoCAD ima potpuno definisanu strukturu zahteva za unos. Prvo zadajete komandu
koja za uzvrat nudi opcije u obliku zahteva za unos. Zavisno od opcije koju tada izabe-
rete, moze se desiti da dobijete drugi skup opcija, ili da zahtev za unos naloZi da nesto
uradite (recimo, da izaberete tacku, objekat ili da unesete vrednost).

Kao $to je prikazano na slici 2.10, redosled komandi podseca na grananje drveta.
VeZbaijte, i sasvim Cete se sroditi sa ovim, u sustini rutinskim postupcima. Posto pot-
puno savladate rad s paletama alatki, komandnim prozorom i okvirima za dijalog, osta-
tak programa modi éete nauciti i sami.

SLIKA 2.10
Tipi¢na struktura
komandi na pri-
meru komande
Arc. Videdete razli-
Cite poruke, zavi-
sno od opcije koju
izaberete dok
napredujete kroz
komandu. Ova

Specify start point of arc or [CEnter]:

Specify second point of arc or [CEnter/ENd]:
Specify end point of arc:

Specify end point of arc: (pick an endpoint location)
Specify center point of arc or [Angle/Direction/Radius]:

Specify tangent direction for the start point: of arc:

Specify center point of arc: (pick a center point)
Specify start point of arc: (pick a start point)
Specify end point of arc or [Angle/chord Length]:

|
Specify length of chord:

Specify Included angle:

(Indicate a chord length)
(Indicate an angle)

(Pick a point for the end
of the arc)

Specify radius of arc:

(Indicate a radius)
(Indicate a direction angle)
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Specify included angle of arc:
L (Indicate an including angle)

slika pokazuje
kako sve mozete
nacrtati lk.

Specify center point of arc: (Pick an endpoint location)
Specify end point of arc or [Angle/chord Length]:

Specify length of chord:

I—) (Indicate a chord length)

(Indicate an angle)
(Pick a point for the end of the arc)

Specify included angle:

\————————— > (Pick a point for the end of the arc)

BIRANJE OPCIUJA 1Z PRIRUCNOG MENUJA

Sada znate da moZete izabrati opcije komandi tako §to cete ih otkucati. Isto tako, moZete
pritisnuti desni taster miSa u bilo kom stadijumu komande da biste otvorili priru¢ni
meni koji sadrZi te iste opcije. Na primer, u koraku 2 iz prethodnog veZbanja, uneli ste CO
da biste AutoCAD-u saopstili da birate centar liika. Umesto da to otkucate, mozete priti-
snuti desni taster misa da biste otvorili priru¢ni meni sa opcijama koje u tom trenutku
moZete primeniti na komandu Arc.

Enter
Cancel

Snap Owverrides

Pan
Zoam

Pored opcija prikazanih u zahtevu za unos komandi, priru¢ni meni nudi i jo§ neke
opcije, na primer, Enter, Cancel, Pan i Zoom. Opcija Enter jednaka je pritiskanju O.
Opcija Cancel ponistava tekuc¢u komandu. Opcije Pan i Zoom omogucavaju da podesa-
vate prikaz dok radite s teku¢om komandom.

Tokom rada u AutoCAD-u, otkricete da u bilo kom trenutku moZzete pritisnuti desni
taster miSa da biste dobili spisak opcija, poznat kao prirucni meni (engl. shortcut menu).
Ovaj meni zavisi od konteksta, tako da cete videti samo one opcije koje se odnose na
odredenu komandu ili aktivnost koja je u toku. Ako pritisnete desni taster misa kada
AutoCAD ocekuje tacku, izbor objekta ili numeric¢ku vrednost, nece se pojaviti priru¢ni
meni. AutoCAD ¢e u tom slucaju pritiskanje desnog tastera misa tretirati kao .
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Imajte na umu da poloZaj kursora u trenutku kada pritisnete desni taster misa odre-
duje sadrZaj priru¢nog menija. Vec ste videli da moZete pritisnuti desnim tasterom misa
neku paletu alatki da biste dobili spisak ostalih paleta. Ako pritisnete desnim tasterom
mis$a u komandnom prozoru, prikazace se spisak operacija koje moZete primeniti, kao
§to je ponavljanje jedne od poslednjih pet komandi koje ste koristili, ili kopiranje
poslednjih komandnih aktivnosti na Clipboard.

t Commands # ARC

LIME
Soprs DSETTINGS
Copy History SAVEAS
Paste
Faste Tio CridLine J_'_
T Optians...

Ako pritisnete desnim tasterom mi$a povr$inu za crtanje kada nijedna komanda nije
aktivna, prikazace se skup osnovnih funkcija za unosenje izmena u datoteku, a neke od
njih su Cut, Paste, Undo, Repeat (ponavljanje poslednje komande), Pan i Zoom.

Repeat ARC

Cut

Copy

Copy with Ease Point

Paste

Paste a5 Block

Baste bo Original Coordinates

Undo
Redo
Fan

Zoarm

Quick, Select. ..
Find...
Options. ..

Kada se nadete u nedoumici $ta da uradite u AutoCAD-u, pritisnite desni taster misa
i pogledajte spisak funkcija. Kasnije u knjizi biée vise re¢i o tim funkcijama. Zasad, poza-
bavimo se problemom izbora objekata.

SAVET  Ako ste iskusan korisnik AutoCAD-a i viSe biste voleli da svako pritiskanje desnog
tastera misa bude jednako pritiskanju U (kao u verzijama koje su prethodile AutoCAD-u 14),
podesite ponasanje AutoCAD-a. U dodatku A naci cete detalje o tome kako da podesite desni
taster misa. Imajte na umu da su vezbanja u knjizi podesena tako da se podrazumeva da Ce se,
kad pritisnete desni taster misa, otvoriti prirucni meni.

Izbor objekata

AutoCAD raspolaze mnogim opcijama za izbor objekata. Ovaj odeljak je podeljen na dve
celine. U prvoj razmatramo izbor objekata na nacin specifican za AutoCAD. Druga
celina se bavi metodom izbora objekata koja se koristi u najpopularnijim grafickim pro-
gramima — Noun/Verb. Dobro je da se sa ovim metodama upoznate na samom pocetku
jer one imaju jednu od najvaznijih uloga u radu sa AutoCAD-om.
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Ako objekte treba da birate po njihovim karakteristikama umesto po njihovom

poloZaju, koristite alatke Quick Select and Object Selection Filters (brz izbor i filtri za izbor

objeka

ta) opisane u poglavlju 12. Ove alatke omogucavaju da lako izaberete skup objekata na

osnovu njihovih osobina, ukljucujuci tip objekta, boju, dodeljene slojeve itd.

Izbor objekata u AutoCAD-u

Mnoge komande AutoCAD-a daju zahtev za unos Select objects: (izaberite objekte).

Pored

ovog zahteva za unos, i kursor menja oblik u mali kvadrat (slika 2.7). Uvek kada

vidite ovakav zahtev za unos objekata i Cetvrtasti kursor za izbor objekata, na raspola-
ganju je nekoliko opcija za izbor. Cesto se desava da se predomislite dok birate objekte na
ekranu ili da slucajno izaberete objekat koji niste hteli. Pogledacemo vecinu raspolozivih

opcija

za izbor u AutoCAD-u i nauciti $ta treba da radite ako izaberete pogres$an objekat.

Pre nego §to nastavite, iskljucite opcije Running Osnap i Osnap Tracking. Iako veoma
korisne, one mogu da zbunjuju pocetnike. S njihovim osobinama detaljnije ¢ete se upo-
znati kasnije u knjizi. Zasad upotrebite ove korake da biste ih iskljucili:

1.

Najpre proverite da li su opcije Running Osnap i Osnap Tracking uklju¢ene. Da
biste to uradili, pogledajte dugmad na kojima piSe Osnap i Otrack, na statusnoj
traci pri dnu AutoCAD-ovog prozora. Ako su opcije ukljucene, njihova dva dugmeta
izgledaju kao da su pritisnuta. Ukoliko izgledaju kao na sledecoj slici, nastavite.

SMNAF| GRID| ORTHO| POLAR| DSMAPY DTHACKM MODEL

. Da biste iskljucili opcije Running Osnap ili Osnap Tracking, pritisnite dugme

Osnap, odnosno Otrack — oba su na statusnoj traci. Kada su iskljucena, izgledace
kao da nisu pritisnuta.

Nastavimo i pogledajmo kako da izaberemo objekat u AutoCAD-u.

+

SLIKA 2.11

Prikaz izabranog

objekta (vr:

predstavljen je

tackastim
linijama.

Izaberite ikonicu Move s palete Modify ili otkucajte M.

Na zahtev za unos Select objects: izaberite dve horizontalne linije koje ¢ine
crtez vrata. Kao §to znate, uvek kada AutoCAD trazi da izaberete objekat, kursor
menja oblik u mali kvadrat. To znaci da ste u rezimu rada za izbor objekta (engl.
object selection mode). Izabrani objekat se na ekranu prikazuje tackastom linijom
(slika 2.11).

ata)
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SLIKA 2.12
Biranje obj

vrata obuhvacde-
nih prozorom.
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. Posto ste izabrali objekte, moZete ponistiti izbor nekih od njih. Pritisnite U0 na

tastaturi. Jedna od linija viSe nije prikazana kao tackasta. Kada pritisnete U[],
ponistavate izbor objekata, jednog po jednog, obrnutim redosledom od onog
kojim ste ih birali.

. Postoji jos jedan nacin da ponistite izbor objekata: drzite pritisnut taster Shift i

izaberite liniju koja je ostala tackasta. Linija opet postaje puna, $to znaci da nije
vise izabrana.

. Dosad ste verovatno ponistili izbor obe linije. Pokusajmo s jos jednom metodom

izbora grupe objekata. Da biste obuhvatili objekte prozorom, otkucajte WC. Kur-
sor menja oblik u kursor za izbor tacaka, a zahtev za unos se menja u:

Specify first corner: (Zadajte prvi ugao)

. Izaberite tacku ispod i levo od pravougaonika koji predstavlja vrata. Dok pome-

rate kursor preko ekrana, pojavljuje se prozor koji se $iri preko povrSine za
crtanje.

. Posto prozor potpuno obuhvati vrata (ali ne i 1tik), pritisnite taster misa i izabrali

ste vrata. Pomocu prozora birate samo objekte koji su potpuno obuhvaceni
njime, kao §to je prikazano na slici 2.12.

ekta

Drugi ugao prozora

e

Prvi ugao prozora

L.,

Nemojte da pobrkate prozor za izbor iz prethodne vezbe s prozorom Zoom, koji ste

koristili u poglavlju 1; prozor Zoom definise povrsinu crteza koju treba uvecati. Zapamtite da

opcija

Window komande Zoom radi razlicito od prozora drugih komandi za uredivanje.

UPOZORENJE  Kada koristite misa, a niste sasvim ovladali njime, veoma lako se moZe desiti
da slucajno pritisnete desni taster misa umesto levog tastera za izbor, i obratno. Ako pritisnete
pogresan taster, dobicete pogreSan rezultat. Ukoliko mis ima dva tastera, desni taster ce se
ponasati ili kao taster U ili cete njime otvarati prirucni meni, u zavisnosti od tekuce radnje. Kao
taster U ponasace se pri izboru objekata, a u ostalim slucajevima pojavljuje se prirucni meni.

8.

Posto ste izabrali cela vrata, bez ltika, pritisnite (. Na taj nacin obavestavate Auto-
CAD da ste izabrali objekte. Nemojte zaboraviti da pritisnete 00 odmah posto iza-
berete objekte koje hocete da menjate. Pojavljuje se nov zahtev za unos, Specify
base point or displacement: (zadajte baznu tacku ili pomeranje), a kursor

menja oblik u kursor za izbor tacaka.
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Sada znate kako se biraju objekti u AutoCAD-u, ali jo§ smo usred komande Move.
U sledecem odeljku govoriéemo o zahtevu za unos koji se upravo nalazi na vasim ekra-
nima, i 0 uno$enju baznih tacaka i rastojanja za pomeranje objekta.

DEFINISANJE BAZNIH TACAKA

Kada pomerate ili kopirate objekte, AutoCAD traZi da zadate baznu tacku (engl. base
poinf). AutoCAD-u morate posebno zadati odakle i dokle se objekat pomera. Bazna
tacka je precizno odredeno mesto i u odnosu na nju definiSete rastojanje i smer pome-
ranja. PoSto definiSete baznu tacku, AutoCAD-u moZete zadati pravac pomeranja
objekta u odnosu na nju. Isprobajte sledeci postupak da biste uvezbali kori§éenje
baznih tacaka:

1. Da biste izabrali baznu tacku, drzite pritisnut taster Shift i pritisnite desni taster
miSa. Na ekranu se pojavljuje meni Object Snap (Osnap).

UPOZORENJE  Kada pritiskate desni taster miSa, proverite da li se kursor nalazi unutar
povrsine za crtanje. U suprotnom, necete dobiti rezultate opisane u knjizi.

Tempaorary track poink
Fram

Mid Between 2 Paints
Paint Filkers 3

Endpoint

Midpoink
Intersection
Apparent Inkersect
Extension

Center
Quadrant
Tangenkt

Perpendicular
Parallel

MNode

Insert
Mearest
Mone

Osnap Setkings. ..

2. Iz menija Osnap izaberite Intersection. Meni Osnap nestaje.

3. Pomerite kursor do donjeg desnog ugla vrata. Primeticete da se u uglu pojavljuje
malo x. To je marker Osnap.

4. Kada se pojavi marker Osnap, ne pomerajte misa nekoliko sekundi. Dobicete

poruku da je AutoCAD izabrao tacku Osnap.

Sada pritisnite levi taster misa da biste izabrali presek oznac¢en markerom Osnap.

Kada marker Osnap vidite na tacki koju hocete da izaberete, ne morate kursorom

pokazati tacno mesto. Samo pritisnite levi taster mi$a i tacka Osnap je precizno

izabrana (slika 2.13). U ovom slucaju, izabrali ste tacno presek dve linije.

6. NazahtevzaunosSpecify second point of displacement or <use first
point as displacement>: (zadajte drugu tacku pomeranjaili <upotrebite prvu
tacku kao pomeranje>), drZite taster Shift i ponovo pritisnite desni taster misa.
Ovog puta, pojavice se Endpoint Osnap. Umesto da opciju izaberete pomocu
misa, otkucajte slovo E.

o
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SLIKA 2.13
Kori$cenje
kursora Osnap.

Marker preseka

________________

ntersection

A

7. Sada izaberite donji desni kraj ltika koji ste ranije nacrtali. (Upamtite, kursor treba
samo da pribliZavate krajnjoj tacki dok se ne pojavi marker Osnap.) Vrata se
pomeraju tako da se izabrani presek vrata precizno spaja s krajnjom tackom ltika
(slika 2.14).

SLIKA 2.14
Pravougaonik u
novom poloZaju
posle koriséenja
opcije Endpoint
Osnap.

Marker krajnje tacke

,,,,,,,,,,,,,,

wr

Kao $to vidite, opcija Osnap omogucava da izaberete odredene tacke na objektu.
U ovoj veZbi koristili ste opciju za izbor krajnje tacke (Endpoint) i opciju za izbor pre-
seka (Intersection), ali na raspolaganju imate i druge opcije koje ¢u objasniti kasnije,
u poglavlju 3. MozZda ste primetili da je marker Osnap drugaciji za svaku opciju koju ste
koristili. O tome €e biti vise reci u poglavlju 3, a sada nastavimo sa izborom tacaka.
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KONTROLA PRIKAZA NA STATUSNOJ TRACI

Na krajnjoj desnoj strani statusne trake videcete strelicu nadole. Ona otvara meni kojim kon-
troliSete prikaz statusne trake. Ovaj meni koristite da biste funkcije koje se nalaze na status-
noj traci ukljucili ili iskljucili. Ako se pored naziva funkcije nalazi znak za potvrdu, znaci da je
funkcija aktivna. Ukoliko, iz nekog razloga, ne vidite dugmad koju smo pomenuli u prethod-
noj vezbi, proverite u ovom meniju jesu li sve opcije na statusnoj traci ukljucene. Verzija LT
nema opciju Otrack na statusnoj traci.

ol

| v Cursor coordinate values (F&)

I v Snap (F9)
i Grid (F7}
~  Ortho (Fa)
~| w Polar (F10)
_|_>|—I v O5nap (F3)
v OTrack (F11}
_ v Lineweight
v Paper/Model

|
— Tray Settings...
JDEL g i

SAVET  Verovatno ste primetili porukuUse first point as displacement uzahtevu za
unos u koraku 6. To znaci da ce se, ako pritisnete [] umesto da izaberete neku tacku, objekat
pomeriti na osnovu koordinata tacke koju ste izabrali kao baznu. Ako je, na primer, tacka koju
ste izabrali na koordinati 2,4, objekat ce se pomeriti 2 jedinice po x osi i 4 jedinice po y osi.

Ako precizno rastojanje i smer pomeranja ili kopiranja objekta upisujete preko tasta-
ture, izaberite bilo koju tacku na ekranu kao baznu tacku. MozZete i samo upisati znak @
i pritisnuti O kao odgovor na zahtev za unos; zatim upisite relativne koordinate druge
tacke. Upamtite, @ oznacava poslednju izabranu tacku. U sledecéoj vezbi pomericete
cela vrata za 1 jedinicu, pod uglom od 45 stepeni. Korisnici metrickog sistema pomerice
vrata za 3 jedinice, pod uglom od 45 stepeni. Sledite ove korake:

1. Izaberite alatku Move s palete Modify.

2. Unesite PO. Skup objekata koje ste obuhvatili prethodnom veZzbom postaje iza-

bran. P je opcija koja bira prethodno izabran skup objekata.

Posto jos radite u rezimu za izbor objekata (engl. object selection mode), izaberite

lik da i njega ukljucite u izabrane objekte. Cela vrata, ukljucujudi i ltik, postaju

izabrana.

4. Pritisnite 0 da biste obavestili AutoCAD da ste zavrsili izbor. Kursor postaje kursor
za izbor tacaka.

5. Pojavljuje se zahtev za unosBase point or displacement: (bazna tacka ili
pomeranje). Izaberite baznu tacku na mestu izmedu vrata i leve strane ekrana
(slika 2.15).

ot
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SLIKA 2.15
Izabrana vrata i
bazna tacka levo
od vrata. Bazna
taCka se ne mora
nalaziti na
objektu koji \
pomerate. ESSSSoosssoossosd

A
i

Bazna tacka
I—o ®

6. Polako pomerajte kursor i primetic¢ete da se pomeraju i vrata, kao da je bazna
tacka koju ste izabrali pricvrScena za njih. Vrata se pomeraju s kursorom, na stal-
noj udaljenosti od tacke, $to ilustruje odnos bazne tacke i izabranog objekta.

7. UpiSite @1<450. Korisnici metrickog sistema neka upisu @3<45L[. Vrata se pome-
raju na nov poloZaj na ekranu, na udaljenost od jedne jedinice (tri jedinice) od
prethodnog poloZzaja i pod uglom od 45 stepeni.

SAVET  Ako AutoCAD ceka da zadate komandu, poslednju zadatu komandu moZete pono-
viti tako $to Cete pritisnuti razmaknicu ili taster U. Isto tako, moZete pritisnuti desnim tasterom
misSa povrsinu za crtanje i izabrati opciju s vrha spiska. Ako desnim tasterom misa izaberete
komandni prozor, prirucni meni e ponuditi poslednje koris¢ene komande.

VeZba pokazuje da se bazna tacka ne mora nalaziti na objektu na kome radite, ona
moZe biti bilo gde na crtezu. Videli ste da moZete ponovo da izaberete skup objekata koji
su ve¢ bili izabrani, a da ne ponavljate postupak biranja.

OSTALE OPCIJE ZA 1ZBOR

Postoji jos nekoliko opcija za izbor koje niste isprobali. U veZbama koje slede videcete kako rade,
a ako ste nestrpljivi, isprobajte ih i sada. Da biste upotrebili te opcije, upisite njihove skracenice
preko tastature (ispisane su u zagradama) na svaki zahtev za unos Select object:.

All [alld] Ovom komandom birate sve objekte s crteza, izuzev slojeva koji su zamrznuti
ili zakljucani (vise detalja o slojevima naci c¢ete u poglavlju 4).

Crossing [c[]] Sli¢na je opciji Select Window, samo §to se pomocu nje biraju svi objekti
koji su u celosti ili delimi¢no obuhvaceni prozorom.

Crossing Polygon [cp[]] Ponasa se sli¢cno opciji Window Polygon, s tim sto se, kao i kod
opcije Select Crossing, biraju svi objekti koji su u granicama poligona ili prelaze preko.

Fence [f(J] Pomocu ove opcije biraju se objekti preko kojih prelazi priviemena linija koja
se zove ograda (engl. fence). Izgleda kao da ste linijjom precrtali objekte koje hocete da
izaberete. Kada aktivirate ovu komandu, tacke mozZete birati na isti nacin na koji to radite
kada crtate niz linijskih segmenata. Po zavrsenom radu sa ,,ogradom” pritisnite [J, a zatim
birajte druge objekte ili ponovo pritisnite O da biste zavrsili biranje.
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Last [I0] Pomocu ove opcije birate objekat koji ste poslednji nacrtali.

Multiple [m] Omogucava da izaberete nekoliko objekata unapred, pre nego sto ih
AutoCAD istakne. Kada radite s velikim datotekama, a pojedinacno birate objekte, Auto-
CAD pravi pauzu posle svakog izbora jer mu treba vremena da locira i istakne svaki obje-
kat. Opcija Multiple ubrzava postupak dozvoljavajudi da prvo brzo oznacite sve objekte, a

zatim ih izaberete pritiskom na [O. Ova opcija nema svoj ekvivalent u menijima.

Previous [p0] Ova opcija omogucava da izaberete poslednji objekat ili skup objekata
koji su prethodno bili menjani ili samo izabrani.

Window [w] Pomocu ove opcije moZete prikazati standardan prozor za izbor. Ona je
prigodna kada je prozor za crtanje ispunjen brojnim elementima crteza tako da se opci-
jom Autoselect ne moZe obuhvatiti skup Zeljenih objekata (pogledajte stavku Auto). Pri-
mena standardnog prozora sprecava da slucajno izaberete objekat koji niste hteli.

Window Polygon [wp[] Objekte birate obuhvatajuci ih poligonom nepraviinog
oblika. Kada koristite ovu opciju, pojavljuje se zahtev za unos First polygon point:
(Prva tacka poligona). Tada birate tacke kojima su definisane granice poligona. Dok
birate tacke, pojavljuje se poruka Undo/<Endpoint of line>: (Ponisti/<Krajnja tacka
linije>). Izaberite onoliko tacaka koliko vam je potrebno da biste zadali granice. Delove
granicne linije moZete tokom rada ponistiti tako Sto cete pritisnuti alatku Undo s palete
Standard ili tako Sto cete pritisnuti taster U na tastaturi. Kada definisete granice, pritisnite
0. Obuhvaceni objekti bice izabrani i vraca se zahtev za unos Select object omoguca-
vajuci da upotrebite i druge opcije za izbor.

Sledece dve opcije za biranje takode su dostupne, ali se veoma retko koriste. Namenjene

su formiranju prilagodenih opcija menija ili prilagodenih alatki s paleta.

Auto [aul]] Ako izaberete tacku izvan objekta, aktivira se standardni automatski prozor
(engl. window) ili presecni prozor (engl. crossing window) — pogledajte odeljak Upotreba
opcije za izbor Autoselect u ovom poglavlju. Standardni prozor se aktivira kada se dva
ugla prozora biraju sleva nadesno. Presecni prozor se aktivira kada se dva ugla izaberu
zdesna nalevo. Ako izaberete ovu opciju, ona ostaje aktivna dok ne izaberete sledecu
komandu. Opcija Auto je namenjena upotrebi u sistemima kada je funkcija automatskog
izbora iskljucena.

Single [siCJ] Ova opcija primorava tekucu komandu da izabere samo jedan objekat.
Ako je upotrebite, moZete izabrati jedan objekat; tada se tekuca komanda odmah
izvrSava kao da ste pritisnuli O ¢im ste izabrali objekat. Ova komanda nema ekvivalent u

menijima.

Izbor objekata metodom Noun/Verb

Danas gotovo svi graficki programi omogucavaju izbor objekata metodom Noun/Verb.

Ta metoda zahteva da objekte izaberete pre nego $to zadate komandu za njihovo uredi-
vanje. To znaci da treba da identifikujete ,imenicu” (engl. noun, u ovom slucaju objekta
na kojem cete raditi), pre nego Sto definiSete ,glagol“ (engl. verb, ovde je to akcija koju
cete sprovesti). U sledec¢im veZbama pokazacéu kako se ova metoda koristi u AutoCAD-u.

Videli ste da AutoCAD prikazuje krsti¢ s malim kvadratom kada oc¢ekuje komandu.

Taj kvadrat, koji je pridodat kursoru, oznacava da pomocu kursora moZete birati
objekte. Program obave3tava da kursorom moZete birati objekte iako na komandnoj
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liniji, koja se nalazi na dnu ekrana, nijedna komanda nije aktivna. Kvadrat nestaje istog
trenutka kada aktivirate komandu koja trazi da izaberete tacke.

SAVET  Pored ove metode za izbor objekata, AutoCAD nudi i druge opcije za izbor koje vam
omogucavaju da koristite poznate tehnike grafickog radnog okruZenja. U dodatku B saznacete
kako se upravlja metodama izbora objekata. U tom dodatku opisano je i kako da promenite
veli¢inu standardnog kursora (engl. standard cursor).

Poku$ajmo sada da pomerimo objekte. Prvo ¢emo ih izabrati, a zatim upotrebiti
komandu Move.

1. Najpre dvaput pritisnite taster Esc da biste bili sigurni da AutoCAD nije usred
komande koju ste mozda sluc¢ajno zadali. Zatim izaberite ltik. Dok birate ik, na
njegovoj srednjoj tacki i na njegovim krajnjim tackama pojavljuju se kvadratici.
Vec¢ smo pomenuli da se ti kvadratici zovu cvorovi (engl. grips). Nesto kasnije bice
prilike da radite s njima.

2. Izaberite Move s palete Modify. Kursor se pretvara u kursor za izbor tacaka. Obra-
tite paZnju na to da ¢vorovi na liku nestaju, ali je lak i dalje izabran.

3. Na zahtev za unos Base point: (bazna tacka), izaberite bilo koju tacku na
ekranu. Pojavljuje se zahtev za unos To point: (do tacke).

4. UpiSite @1<001. Korisnici metrickog sistema neka unesu @3<00C. Liik se premesta
na nov poloZaj, udaljen jednu jedinicu (3 jedinice) nadesno.

UPOZORENJE  Ako je rezultat vezbe drugaciji nego Sto je ovde opisano, moZda je u vasoj
kopiji AutoCAD-a metoda Noun/Verb iskljucena. Da biste je aktivirali, uradite sledece: izabe-
rite Tools > Options i otvorice se okvir za dijalog Options. Zatim izaberite karticu Selection.
U grupi Selection Modes ukljucite metodu izbora Noun/Verb. Pritisnite OK kada zavrsite.

U ovoj veZzbi liik ste izabrali pre nego §to ste zadali komandu Move. Kada ste izabrali
alatku Move, nije se pojavila poruka Select object:. Umesto toga, AutoCAD pretpo-
stavlja da ste izabrani lik hteli da pomerite i odmah prelazi na zahtev za unos Base
point:[.

UPOTREBA OPCIJE ZA 1ZBOR AUTOSELECT
U sledecem koraku, pomocu opcije Autoselect pomeramo ostatak vrata u istom smeru.

1. Izaberite ispod i levo od pravougaonika koji predstavlja vrata. Proverite da niste
slu¢ajno izabrali i sama vrata. Pojavljuje se prozor za izbor koji moZete razvlaciti
po ekranu dok pomerate kursor. Ukoliko kursor pomerite levo od poslednje iza-
brane tacke, konture prozora bice prikazane tackastim linijama (gornji crtez sa
slike 2.16). Ako kursor pomerite desno od izabrane tacke, konture prozora ponovo
postaju pune (donji crtez sa slike 2.16).

2. Sada izaberite tacku ispod i desno od vrata, tako da vrata ostanu potpuno obu-
hvacena prozorom (donji crteZ na slici 2.16). Vrata postaju izabrana (ponovo
moZete videti ¢vorove koji se pojavljuju na krajnjim tackama i sredinama izabra-
nih linija).

3. Aktivirajte ponovo alatku Move. Pojavljuje se zahtev za unos bazne tacke kao i
u prethodnoj veZbi.

4. Izaberite bilo koju tacku na ekranu, zatim upiSite @1<00 (@3<00 za korisnike
metrickog sistema). Vrata se spajaju s likom.



SLIKA 2.16
Tackasti prozor
(gornji crtez)
ukazuje na to
da je aktivirana
opcija za izbor
metodom pre-
secnog prozora;
prozor punih
ukazuje na to
da je aktivirana
opcija za izbor
standardnim
prozorom.

IZBOR OBJEKATA

A

Preseéni prozor

L.

=

Standardni prozor za izbor

Dva razlicita prozora za izbor — tackasti prozor i prozor punih linija — predstavljaju
presecni prozor (engl. crossing window) i standardni prozor (engl. standard window).
Ukoliko koristite standardni prozor, bice izabrano sve §to je u celini njime obuhvaceno.
Ako koristite prese¢ni prozor, bice izabrano sve §to prolazi i ono §to je u prozoru. Te dve
vrste prozora pokrecu se automatski kada standardnim kursorom ili kursorom za izbor
tacaka pritisnete bilo koji prazan deo povrsine za crtanje; otud naziv Autoselect.

Sada cete objekte birati pomocu automatskog presecnog prozora.

1. Izaberite tacku ispod i desno od vrata. Dok pomerate kursor nalevo, pojavljuje se
presecni (tackasti) prozor.

2. Izaberite sledecu tacku tako da prozor obuhvati vrata i deo ltika (slika 2.17).
Izabracete cela vrata zajedno s ltikom.

3. Izaberite alatku Move.
4. Izaberite bilo koju tacku na ekranu i upisite @1<1800 (@3<1800 za korisnike

metrickog sistema). Vrata se vracaju u prvobitni poloZaj.
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SLIKA 2.17
Vrata obuhva-
¢ena presecnim
prozorom.

Tokom rada postace jasno da su, u veéini slucajeva, za biranje objekata jedino potre-
bni standardni prozor i prese¢ni prozor opcije za izbor Autoselect. Oni Stede vreme, pa
bi valjalo da dobro savladate rad s njima.

Pre nego $to nastavimo, upotrebite komandu File > Save da biste snimili datoteku
Vrata. Nije potrebno da sac¢uvate izmene koje ¢emo uneti u sledecoj veZzbi, te zato crtez
snimite sada i sacuvajte ga u sadasnjem obliku.

Ogranicenja za izbor objekata metodom Noun/Verb
Ako objekte radije birate metodom Noun/Verb, treba da znate da se ona koristi sa odre-
denom podgrupom AutoCAD-ovih komandi. Nabroja¢emo ih po abecednom redosledu:

Array Copy Hatch Rotate
Block Dview List Scale
Change Erase Mirror Stretch
Chprop Explode Move Whblock

Kada primenjujete komandu kojom se bira viSe od jedne grupe objekata, ne mozete
koristiti metodu Noun/Verb. Ovu listu ne morate pamtiti zato $to éete odmah znati da li
komanda prihvata izbor objekata metodom Noun/Verb. Komande koje ga ne prihvataju
obrisace izbor, a zatim prikazati zahtev za unos Select object:.

Sada je pravi trenutak da napravite pauzu. Izadite iz AutoCAD-a i kasnije se vratite na
ovo mesto u knjizi. Kada budete Zeleli da nastavite, pokrenite AutoCAD i otvorite dato-
teku Vrata.

Upotreba cvorova za uredivanje objekata
(funkcija Grips)

Dok ste birali vrata, videli ste ¢vorove na krajnjim i srednjim tackama linija i lukova.
Cvorovi se mogu koristiti za neposredno menjanje oblika objekata ili za brzo preme-
Stanje i kopiranje objekata.



UPOTREBA CVOROVA ZA URERIVANJE OBJEKATA (FUNKCIJA GRIPS)

UPOZORENJE  Ako se u prethodnoj vezbi nisu pojavili ¢vorovi na vratima, moZda je u vasoj
verziji programa AutoCAD-a iskljucena funkcija Grips. Kako Cete je ukljuciti, saznacete u tek-
stu o ¢vorovima u poglavlju 12.

Dosad ste naucili da se rad u AutoCAD-u obavlja postupno, u koracima. Na primer,
da biste nacrtali lik, prvo zadajete komandu Arc, zatim prolazite kroz niz radnji koje
uklju¢uju i odgovaranje na zahteve za unos i izbor tacaka. Kada sve to zavrsite, 1tk je
gotov i AutoCAD je spreman za slede¢u komandu.

Funkcija Grips ima drugaciju ulogu. Cvorovi nude mali ali mocan skup funkcija za
uredivanje koje ne podlezu dosad kori§¢enom redosledu komanda/zahtev za unos/
unos. LakSe cete raditi u sledecoj vezbi ako funkciju Grips zamislite kao ,podskup” stan-
dardnih nacina rada sa AutoCAD-om.

Da biste veZbali upotrebu ¢vorova, moracete priviemeno izmeniti sadasnji crtez
vrata (Vrata.dwg).

Rastezanje linija pomocu cvorova

U ovoj veZbi rastegnucete jedan ugao vrata hvatajuci dve linije za ¢vorne tacke.

1. Pritisnite taster Esc da biste bili sigurni da nijedna komanda nije aktivna. Izabe-
rite tacku ispod i levo od vrata da biste aktivirali prozor za izbor.

2. Pritisnite iznad i desno od pravougaonog dela vrata koja treba izabrati.

3. Postavite kursor na donji levi ¢vor pravougaonika, ali ne pritiskajte taster misa.
Obratite paznju na to kako kursor skace na mesto na kome se nalazi ¢vor i kako
¢vor menja boju.

4. Premestite kursor do drugog ¢vora. Vidite da kursor opet skace na ¢vor. Kada se
postavi na ¢vor, kursor se smesta tacno u njegov centar. To znaci da kursor koji se
postavi na ¢vor, recimo krajnje tacke, precizno pronalazi centar krajnje tacke
objekta.

5. Pomerite kursor do ¢vora u gornjem levom uglu pravougaonika i izaberite ga.
Cvor menja boju, pa za njega kazemo da je aktivan ¢vor (engl. hot grip). Pojavljuje
se zahtev za unos:

**STRETCH* *

Specify stretch point or [Base point/Copy/Undo/eXit]:
(Razvucite do tacke ili [bazna tacka/kopiranje/poniStavanje/
izlaz])

Ovaj zahtev obavestava da je komanda Stretch aktivna. Pregledajte opcije koje su
vam na raspolaganju. Dok pomerate kursor, ugao prati njegovo kretanje, a linije
pravougaonika se rastezu (slika 2.18).

SAVET  Veli¢inu i boju ¢vorova moZete menjati preko okvira za dijalog Grips. Detaljnija
objasnjenja pogledajte u poglavlju 12.

6. Pomerite kursor prema gornjem kraju ltika i izaberite tacku tako §to cete priti-
snuti taster misa. Pravougaonik se deformiSe, a uglovi se poklapaju sa izabranom
tackom (slika 2.18).
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SLIKA 2.18
Rastezanje linija
pomocu aktivnih
¢vorova. Gornji
crtez prikazuje
pravougaonik ¢iji
se jedan ugao
rasteZe navise.
Donji crtez poka-
zuje nov polozaj
ugla na vrhu lika.

U ovoj vezbi upoznali ste komandu STRETCH. Nju zadajete tako $to miSem birate ¢vor.
Kao $to Cete videti, na raspolaganju su vam mnoge druge komande za aktivne ¢vorove.

1. Vidite da ¢vorovi i dalje postoje na objektu. MiSem izaberite ¢vor koji ste ranije
pomerili da bi ponovo postao aktivan.

2. Pritisnite desni taster miSa i pojavljuje se priru¢ni meni sa opcijama za menjanje
cvorova.

Enker

Move
Mirror
R.otate
Scale
Stretch

Base Point

Copy
Reference
Undo

Properties

Exit



UPOTREBA CVOROVA ZA URERIVANJE OBJEKATA (FUNKCIJA GRIPS)

SAVET  Ako izaberete ¢vor u uglu, AutoCAD bira oba ¢vora na linijama koje se preklapaju.
Kad rastegnete ugao od njegovog pocetnog mesta, prate ga krajnje tacke obe linije.

3. Sliste izaberite Base Point i miSem pritisnite tacku desno od aktivnog ¢vora. Ako
sada pomerite kursor, pomerice se i aktivni ¢vor, ali ¢e zadrzati isti odnos prema
kursoru.

4. Ponovo pritisnite desni taster mi$a i zatim izaberite opciju Copy iz priru¢nog
menija pa onda upiSite @1<-300 (@3<-300 za korisnike metrickog sistema).
Umesto da pomerite aktivni ¢vor i promenite linije, pravite kopiju dveju linija cije
su krajnje tacke za 1 jedinicu (3 jedinice) ispod i desno od prethodnih.

Izaberite jo$ jednu tacku, tacno ispod poslednje. Napravicete jo$ kopija.
Pritisnite O ili upiSite XO da biste zavrsili rad s komandom Stretch. Isto moZete
uraditi i ako ponovo pritisnete desni taster miSa i izaberete opciju Exit iz priruc-
nog menija.

Sl

U ovoj vezbi pokazali smo kako se biraju bazne tacke koje nisu aktivni ¢vorovi. Videli
ste i kako moZete zadati relativne koordinate za kopiranje ili premestanje aktivnih ¢vo-
rova. Najzad, ako ste ranije izabrali ¢vorove na nekom objektu, pa pritisnuli desni taster
miSa, videli ste da se otvara priru¢ni meni koji pokazuje opcije menjanja pomocu ¢vorova.

Premestanje i rotiranje pomocu cvorova

Funkcija Grips nudi jo$ jedan nacin da promenite crteZ. Ve¢ znate kako se rastezu krajnje
tacke, ali sa ¢vorovima moZete uraditi i viSe od toga. U sledecoj veZbi naucicete i druge
mogucnosti. Po¢nite tako $to ¢ete ukloniti izmene koje ste uneli u prethodnoj vezbi.

1. Pritisnite alatku Undo s palete Standard ili upi$ite UO. Kopije razvuc€enih linija
nestaju.

2. Pritisnite ponovo 0. Deformisana vrata dobijaju prethodni oblik.

SAVET  Ako pritisnete O u odgovoru na zahtev za unos, nalazete AutoCAD-u da ponovi
poslednju izvrsenu komandu — u ovom slucaju U.

3. Dabiste izabrali cela vrata, postavite kursor u prazan prostor dole i desno od njih,
a zatim pritisnite levi taster misa.

4. Pomerite kursor iznad i levo od pravougaonog dela vrata i pritisnite taster misa.
Posto ste kursor pomerili zdesna nalevo, napravili ste presecni prozor. Setite se da
tako moZete izabrati sve §to je obuhvaceno prozorom i sve preko ¢ega prozor
prelazi.

5. Izaberite donji levi ¢vor pravougaonika da biste ga aktivirali. Kao i ranije, ugao se
rasteze kada pomerate kursor.

6. Pritisnite desni taster mi$a, a zatim u priru¢nom meniju za menjanje ¢vorova iza-
berite opciju Move. U komandnom prozoru pokazuje se sledece:

**MOVE**
<Move to point>/Base point/Copy/Undo/eXit:
(<Pomeriti u tacku>/bazna taCka/kopiranje/ponis$tavanje/izlaz)

Sada, kako pomerate kursor, tako se pomeraju i cela vrata.
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7. Postavite vrata blizu centra ekrana i pritisnite taster misa. Vrata se pomeraju u
centar ekrana. Ponovo se pojavljuje zahtev za unos, a vrata ostaju izabrana, §to
znaci da mozZete preci na sledecu operaciju.

8. Izaberite ponovo donji levi ¢vor, pritisnite desni taster mi$a i iz priru¢nog menija
izaberite opciju Rotate. U komandnom prozoru pojavljuje se:

**ROTATE** <Rotation angle>/Base point/Copy/Undo/Reference/eXit:
(<ugao rotacije>/bazna tacCka/kopiranje/poni$tavanje/referentni
pravac/izlaz)
Kada pomerate kursor, vrata rotiraju oko tacke koja se nalazi na izabranom ¢voru.
9. Postavite kursor tako da se vrata rotiraju otprilike za 180 stepeni (slika 2.19).

Zatim, drZedi taster Shift, pritisnite taster misa kojim birate. Pojavljuje se kopija
vrata, a originalna vrata ostaju na mestu.

10. Pritisnite 0 da biste zavrsili rad u reZimu za menjanje pomoc¢u ¢vorova.

SLIKA 2.19
Rotiranje i kopi-
ranje vrata
pomocu aktivnih
¢vorova. Vise a..
objekata se menja )
pomocu ¢vorova T
iako je aktivan K
samo jedan cvor.

SAVET  Videli ste kako se komanda Move drukdije ponasa kada se koristi uz primenu aktiv-
nih cvorova. I ostale komande za rad sa aktivnim cvorovima (Stretch, Rotate, Scale i Mirror)
imaju odgovarajuce komande u standardnom skupu AutoCAD-ovih komandi. U poglavljima
91 11 saznacete kako one rade.

Kada zavrsite bilo koju operaciju sa aktivnim ¢vorovima, objekti i dalje ostaju iza-
brani, a ¢vorovi su im i dalje aktivni. Da biste ponistili izbor ¢vorova, pritisnite taster
Esc.

U ovoj veZbi videli ste da se komande za aktivne ¢vorove pojavljuju u priru¢nom
meniju. Jo§ neke opcije dostupne su iz ovog menija, ukljucujuci Exit, Base Point, Copy
i Undo. Osobine objekata moZete menjati i koristeci opciju Properties.

Mnoge od ovih opcija za menjanje ¢vorova moZete izabrati i ako pritisnete razmak-
nicu ili taster Okada je ¢vor izabran. Svaki put kada pritisnete neki od tih tastera, aktivira
se sledeca opcija. Opcije se ponavljaju sve dok pritiskate . Taster Shift se ponasa kao
precica za komandu Copy. Upotrebite ga samo jedanput i svaki sledeci put kada izabe-
rete tacku pritiskajuci taster misa, pravi se kopija.



POMOC TOKOM RADA

KRATAK PREGLED MOGUCNOSTI FUNKCIJE GRIPS

U veZzbama u ovom poglavlju radite sa samo nekoliko opcija funkcije Grips. U poglavljima
koja slede radicete i sa ostalim komandama za aktivne cvorove. Zasad dajem pregled
mogucnosti funkcije Grips.

v Kad izaberete ¢vorove krajnjih tacaka, rasteZete krajnje tacke.

u Ako izaberete ¢vorove srednje tacke, premestate celu liniju.

u Ukoliko se krajevi dva objekta spajaju a vi miSem izaberete preklopljene ¢vorove, birate
oba ¢vora u isto vreme.

u Da biste izabrali viSe ¢vorova drzite taster Shift dok miSem birate odgovarajuce ¢vorove.

v Kada su cvorovi aktivni, na raspolaganju su opcije Stretch, Move, Rotate, Scale i Mir-
ror. Aktivirate ih tako $to pritisnete desni taster misa.

u Mozete ciklicno birati opcije Stretch, Move, Rotate, Scale i Mirror tako Sto cete priti-
snuti taster O kada su ¢vorovi aktivni.

u Sve opcije za aktivne ¢vorove omogucavaju da pravite kopije izabranih objekata, bilo
da birate opciju Copy ili da drZite taster Shift dok birate tacke.

u Sve opcije za aktivne ¢vorove omogucavaju da birate baznu tacku nezavisno od prvog
izabranog aktivnog ¢vora.

Pomoc tokom rada
MozZda éete se dvoumiti oko AutoCAD-ovih funkcija a priru¢nik vam nece biti pri ruci.
AutoCAD ima ugradenu pomoc¢ (Help) koja sadrZi podatke o temi koja vas zanima. Evo
kako da pronadete pomo¢:
1. Izaberite Help > Help s linije menija. Pojavljuje se prozor AutoCAD 2005 Help.
2. Izaberite karticu Contents ako ve¢ nije izabrana. Ova kartica pokazuje sadrZzaj.
Postoje jos Cetiri kartice oznacene sa Index, Search, Favorites i Ask Me koje
pomazu da pronadete odredene teme.

SAVET  AutoCAD-ov prozor Help otvarate i tako $to pritisnete taster F1.

gl
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3. Pomerajte sadrzaj ekrana dok ne ugledate stavku Command References dvaput
pritisnite taster mi$a. Oba okvira Help Window menjaju se i prikazuju vise tema.

4. Na desnom okviru pritisnite tasterom misa stavku C s desne strane liste Com-
mands. Okvir se prosiruje i pokazuje listu imena komandi koja poc¢inju sa C.

5. Pomerajte se nizlistu i izaberite re¢ Copy. Pojavice se detaljan opis komande Copy
u okviru na desnoj strani.

6. Izaberite stavku Display All Hidden Text On This Page. Prosirice se okvir u kome
su detaljniji podaci o komandi Copy. Taj pro$ireni prikaz moZete zatvoriti ako,
pomerajudi se nadole, izaberete Collapse All Hidden Text On This Page.

Na vrhu desnog panoa nalaze se i kartice Concepts, Procedures i Reference. Te opcije
sadrZe detaljnije podatke o izabranim stavkama. Ako hocete da se vratite na neki od
koraka koji ste upravo obavili, pritisnite dugme Back na paleti alatki.

Upotreba kartice Search

Kada traZite obaveStenja o nekoj temi na osnovu klju¢ne reci (engl. keyword), moZete
upotrebiti karticu Search iz okvira za dijalog Help. Primenite sledece korake:

1. Izaberite karticu Search koja se nalazi u levom okviru prozora Help. Ako prvi put
birate ovu karticu, videcete poruku kojom AutoCAD saopstava da aktivira indeks
za pretrazivanje.

2. Upisite rec Change u polje na vrhu kartice Search, a zatim pritisnite List Topics ili
0. U okviru se prikazuje spisak svih stavki u sistemu Help koje sadrZe rec change.
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E

Ova lista je prenatrpana. MoZete upotrebiti logicke operacije AND, OR, NEAR i NOT
sa ostalim klju¢nim recima da biste u pretraZivanju primenili filtre, kao kad koristite
obican pretraziva¢ Weba. Kada nadete temu, izaberite je s liste Select topic, i pritisnite
dugme Display da biste u okviru na desnoj strani dobili obavestenja o temi.
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Kartica Ask Me je jo$ jedna alatka u okviru za dijalog Help koja e vas zanimati. Ona
dozvoljava da postavljate pitanja ,svakodnevnim (engleskim) jezikom®. Pratite sledece
korake da biste videli kako radi opcija Ask Me.

1. Izaberite karticu Ask Me (pitaj me).

2. UpiSite How do I zoom into my view na vrhu okvira za unosenje teksta. Spisak
ispod polja za uno$enje teksta menja se i prikazuje nekoliko stavki koje se odnose
na podeSavanje prikaza u AutoCAD-u.

3. Izaberite stavku pod naslovom Magnify A View (Zoom). Desni okvir se menja i
prikazuje kako radi komanda Zoom.

S|
e 9 ) & B

Hide  Back Fowod Home Pt Opfions

Canterts | Indes | earch| Favorpes AskMe |

Type in @ question and press Erter.  Query Tips

| do | zoom inta my view ask|
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[Uoer socumertdion st =] You can change the magnification of a view by zaoming in and aut. Like zoorming
jser documentation s in and out with & camera, ZooM does not change the absolute size of objects in
History. Powered by foswerWorks® the drawing; it changes only the magnification of the view.

[Eook When you wark with minute parts in your drawing, you may need to zoom out

ACR frequently 10 see an averview of your work. Use ZOOM Previous to return quickly
92% To zoominthe 30 Orbit view  AUG o the prior view.

92% Hagniiva, Vliﬁ [Foomi AUG

92% 3DZ00M ACR The options described here are the options most commonly used. Fora
90% To zoom fo edAUtoCAD User's Guide description of all ZOOM options, see the Command Reference.

63% To dispiay the previous view — AUG

Orbit view
during PAN Reattime and Z00M

90% Pan aned Zoom with the Serisl - AUG
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Wiews Window

3% To use a zoom window inthe  AUG
3D Orhit view
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maenification of the Aerisl Wiew
image

83% To zoomto a new areausing  AUG
the Setial Wiews wintiow:

Zoom to Magnify a Specified Rectangular Area

You can quickly zoom on a rectangular area of your drawing by specifying two
diagonal comers of the area you are interested in

83% Torestorethe previous view  AUG

1
83% Procedures ok Madnify a View AUG Zo0Mm window
Zoam ;I =

Desno od svake stavke u listi kartice Ask Me nalazi se troslovni akronim. Na taj nac¢in
vas program obavestava o nazivu izvornog dokumenta za svaku opciju s liste. Na primer,
stavka Magnify A View (Zoom) nalazi se u knjizi AutoCAD User’s Guide (Uputstvo za kori-
snike AutoCAD-a) - skracenica je AUG. Uz druge stavke prikazano je ACR, §to je skrace-
nica od AutoCAD Command Reference (Komande u AutoCAD-u). PretraZivanje moZete
ograniciti i na odredene izvorne dokumente tako $to izvorni dokument izaberete iz
padajuce liste List of components to search.

Ako se pomerate ka dnu liste Ask Me, naci cete opciju Search The Web For:. Ukoliko
ne nadete zadovoljavajuci odgovor u sistemu pomoci AutoCAD-a, moZete izabrati ovu
opciju da biste zapoceli pretraZivanje Web stranice u okviru na desnoj strani. Ako kori-
stite ovu opciju, morate biti povezani s Internetom.

Kartica Index omogucava da nadete odredene teme u sistemu pomoci AutoCAD-a
tako Sto ¢ete upisivati reci u polje List of components to search. Kartica Favorites omo-
gucava da upamtite lokacije sistema pomoci koje Cesto posecujete.
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Koris¢enje pomoci za tekuci kontekst
AutoCAD ima i pomo¢ u vezi s tekuéim kontekstom. Ona vas vodi do tema koje se
odnose na aktivhu komandu. Da biste videli kako to funkcioniSe, uradite sledece:
1. Zatvorite ili smanjite prozor Help i vratite se u prozor AutoCAD.
2. Pritisnite alatku Move s palete Modify da biste pokrenuli komandu Move.

3. Pritisnite taster F1 ili izaberite Help s linije menija. Otvara se prozor Help i prika-
zuje opis komande Move u okviru s desne strane.

B CAD 2005 Help: User Documentation

& e 5 m &8 o

Hide Back  Fomzd Home Print  Options

Contents | Indax | Search | Favoites Ask Me |

MOVE Command
Type in a question and press Enter.  Query Tips

F Concepts Procedures Reference
g ask| ci

Displaces objects a specified distance in a specified direction

List of componerts to search

User documertation st =
Histare Pousred by fosnerliorks
= § Modify toolbar:
Modify menu: Mave

92% Z0O0M ACR

2% To zoom inthe 30 bl view  ALG Shortout menu: Seiect the bjests to move,right-click in the: drawing ares, and

2% Wannity a View (Zoom) AUG chaase Move

3% 3DIOOM ACR EE Command line: move

a0r% Ww AG Select objects: Use an object selection method and press ENTER when you finish

0% batsant foom wiihe Aerl ALG Speciiy base point or displacement: Specifya base point (13
I — Specify second point of displacement or <use first point as displacement=: Specify

9% Touse o zoom window inthe  AUG apoint (2) or press ENTER
3D Orbit view

899% To display the previous view  AUS A & A
during PAN Reaftime and Z00M o,

Eealine Q “

9% Toincrease or decresse AG e _
magnitication of the &etial View 1 £y O
image h

5% Tozoomtosrewareausing  AUS
the Aerial View windovy object selected object moved

899% Torestore the previous view  AUS

9% Frocedures tab: Macrify a View AUG The two points you specify define a displacement vector that indicates how far the
Zoom) x| ||| selected abjects are to be moved and in what ditection. If you press ENTER at the

Suarify Sacnnd Print nf Disalacemant nmmat_the first naint is internretad as =l

4. Pritisnite dugme Close ili taster Esc.
5. Pritisnite taster Esc da biste izasli iz komande Move.

Ako poznajete osnove AutoCAD-a, verovatno Cete Zeleti da instalirate AutoCAD Lear-
ning Assistant (pomo¢ pri ucenju). Ta alatka nudi kratke savete i uputstva za mnoge
teme, ukljucujuci i timski rad i maksimalno iskori§¢enje Windowsovog okruZenja. Lear-
ning Assistant se nalazi na CD-u koji je deo paketa AutoCAD 2005.

Dodatni izvori za trazenje pomodi

Alatka Help Topics je vodedi izvor referentnog materijala, ali odgovore na pitanja
moZete pronaci i u meniju Help. Sledi kratak opis opcija menija Help:

Info Palette Prozor koji nudi trenutni odziv na zadatu komandu. U verziji LT, prozor
Info Palette se otvara podrazumevano. Ova opcija moZe da bude korisna za pocetnike,
ali nekim korisnicima smeta. Da biste je iskljucili, pritisnite dugme za zatvaranje
(dugme X) u gornjem desnom uglu palete. MoZete je ponovo ukljuciti ako izaberete
Help > Info Palette.

Developer Help Posebni podaci namenjeni osobama koje rade na razvoju pro-
grama. To obuhvata i osobe koji se bave prilagodavanjem AutoCAD-a.
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New Features Workshop Lekcije i opisi novih mogucnosti u AutoCAD-u 2005. Ovu
alatku mozete aZurirati preko Autodeskove Web prezentacije.

Online Resources Dodatne opcije koje pokrecu vas ¢ita¢ Web-a i Salje vas na Auto-
deskovu Web lokaciju PointA. Preko ovih opcija moZete pronaci najsveZije informa-
cije o podrsci i obuci za rad u AutoCAD-u.

About Podaci o verziji AutoCAD-a koju koristite.

Informisite se preko centra za komunikaciju

Funkcija centar za komunikaciju (engl. Communication Center) omogucava da budete
u toku sa svim novinama u AutoCAD-u. Na kraju desne strane statusne trake, videcete
ikonicu Communication Center, kao i poruku u oblacicu koja pokazuje na nju.

bl

\i‘) Communication Center IZ‘
. Inc. The easy way to keep you and your software up-to-date.
Click here.

L

P [0TRAEK LwT| [MODEL % .

Pritisnite levim tasterom mi$a ovu ikonicu i otvorice se okvir za dijalog Communica-
tion Center.

@Eommunication Center ﬂ

The Communication Center is your direct
connection to the latest software updstes,
product support announcements and more.
Please follow the configuration steps below
to start using the Communication Center.

Specity your courtry and preferred
update frequency.

Settings

Pritisnite dugme Settings. Otvorice se okvir za dijalog Configuration Settings.

U oblasti Country moZete izabrati svoju zemlju s padajuce liste Country, da biste bili
sigurni da informacija vaZi za vasu zemlju. Opcija Check for New Content omogucava da
izaberete ucestalost kojom c¢e centar za komunikaciju proveravati da li ima novih infor-
macija. MoZete izabrati jednu od opcija: Daily, Weekly, Monthly ili On Demand (dnevno,
nedeljno, mese¢no ili na zahtev). Ako Zelite da iskljucite prikazivanje poruke u oblacic¢u
koja ukazuje na ikonicu Communication Center na statusnoj traci, iskljucite polje za
potvrdu Enable Balloon Notification for new announcements na dnu okvira za dijalog.

Kada prvi put izaberete zemlju, videcete dugme Refresh Content levo od dugmeta Set-
tings u okviru za dijalog Communication Center. Ako ste priklju¢eni na Internet, moZete u
bilo koje vreme pritisnuti ovo dugme i tako proveriti da li ima informacija. Ako postoji bilo
kakva nova informacija, pojavice se upozoravajuca poruka u okviru za dijalog.
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Communication Center radi najbolje ako koristite stalnu vezu sa Internetom kao $to
je DSL ili veoma brzu kablovsku vezu. Ukoliko nemate ovakve moguénosti, moZete
podesiti opciju Check For New Contents na On Demand. Tako cete proveravati da li ima

IZRADA PRVOG CRTEZA

@Conﬁguration Settings

Settings I

“ou must specify & country and a poling frequency ko enable
the Live Update Feature,

[~ Counkry

Please indicate For which country you would like the Live
Update information to be localized.

r~Check for New Content

Please indicate how often you would like your product to
poll the Live Update feature.

Daily ﬂ

i~ Balloon Motification

¥ Enable Balloon Matification For nevw announcements

[o]4 I Cancel | Appli | Help

nekih novosti kada ste prikljuceni na Internet.

Prikazivanje podataka u prozoru Text

Radeci u AutoCAD-u mogli ste da pratite poruke prikazane u prozoru Command. Pone-
kad je korisno pogledati informacije koje su pomerene iz vidljivog dela komandnog pro-
zora. Na primer, moZete pregledati aktivnosti s komandama u svojoj prethodnoj sesiji
da biste proverili ulazne vrednosti ili neke druge unete podatke. Uradite sledecu veZbu

da biste saznali kako radi prozor Text.

1. Izaberite Tools > Inquiry > List.

2. Nazahtevzaunos Select objects: izaberite jedan od lukova i pritisnite 0. U
AutoCAD-ovom prozoru Text (slika 2.20) prikazuju se informacije o ltku. Pri dnu
se nalazi spisak svojstava ltika. Ne brinite ako ne razumete svako svojstvo sa ove
liste. Tokom rada uz knjigu, naucicete $ta znace razlicita svojstva nekog elementa.

3. Pritisnite taster F2. AutoCAD-ov prozor Text se zatvara.

SAVET

i obrnuto.

Traka za pomeranje koja se nalazi desno od prozora Text vodi vas do nekih ranijih
dogadaja. MoZete podesiti ¢ak i broj redova koje ¢e AutoCAD zadrZati u ovom tek-
stualnom prozoru koristeci okvir za dijalog Options. Uz to, AutoCAD moZe da
snimi informacije iz prozora Text u obliku tekstualne datoteke.

Kada je vise dokumenata otvoreno u isto vreme, prozor Text ¢e prikazati listu trenu-
tno aktivnog crteza.

Pomocu funkcijskog tastera F2 brzo prelazite iz editora za crtanje u prozor Text



PRIKAZIVANJE SVOJSTAVA OBJEKTA

SL' KA 2 20 El AutoCAD Text Window - 1\ AutoCAD2004 " ProjectsiChapter Samples'doorsample.d ;Iglﬂ

AutoCAD-ov Edit

tekstualni ekran ) .
. Opening an AutoCAD 2000 format file
pokazu]e podatke FRegenerating model

I)OSle prIDIEIle AutoCAD Express Tools Copyright @ 2002-2003 Autodesk. Inc.
alatke List. AutoCAD menu utilities loaded

Command :

Command :

Command list

Select objects: 1 found

Select objects:

ARC Layer: "0
Space: Hodel space
Handle = 28
center point, E= 7.0000 ¥= S.oooo Z= 0.0000
radius 3.o000

start angle
end angle 90
length 4.7124

Command : 4 | ;J

Prikazivanje svojstava objekta

Dok razmatramo prikazivanje informacija, upoznacete se i s paletom Properties. U pre-
thodnoj vezbi videli ste da je komanda List prikazivala neke informacije o svojstvima
objekta, kao $to je mesto na kome se nalaze centar i krajnje tacke ltika. Osim toga,
moZete dvaput pritisnuti objekat da biste prikazali paletu Properties koja sadrZi slicne
informacije. (U stvari, ponekad i slu¢ajno aktivirate paletu Properties.) Da biste saznali
¢emu sluzi ta paleta, uradite sledec¢u vezbu.

1. Dvaput pritisnite liik u crtezu. Otvorice se paleta Properties u kojoj je prikazan
spisak svojstava tog lika.

Color W Eylayer
Layer u]

Linetype = ——— BylLayer
Linetyp.., 1.0000

Plot style |ByLayer
Linewei. ..

ByLayer
Hyperlink
Thickness |0,0000

Skark ¥ 10,0000
Stark ¥ |5.0000
Stark 2 |0,0000
Center ¥ | 7.0000
Center ¥ | 5.0000
Center £ | 0.0000
Frid % F.nnnn

wn
]
=
=
o
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o
o

o
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SAVET

Ne brinite ako ne moZete rastumaciti mnoge stavke u ovoj paleti. Naucicete viSe o
njoj tokom veZbanja u prvih nekoliko poglavlja ove knjige. Zasad se uverite da se

ova paleta pojavljuje svaki put kada dvaput pritisnete mi§em neki objekat i da su

u njoj prikazana svojstva objekta.

. Pritisnite malo polje Auto-Hide koje se nalazi na dnu palete Properties, sleva. To je

slicica dvostruke strelice. Postace jedna strelica. Opcija Auto-Hide omogucéava da
paleta bude prikazana, a da ne oduzima mnogo od povrsine za crtanje. Ovo moZe
biti korisno pri podeSavanju svojstava mnogih objekata.

e b Frid % F.nnnn

[4m,

£

. Udaljite kursor od palete Properties. Ona ¢e nestati i ostace samo naslovna traka.
. Postavite kursor na ovu naslovnu traku. Otvorice se paleta Properties i ponovo

prikazati sve opcije.

. Pritisnite ponovo polje Auto-Hide da biste ukljucili stalan prikaz palete.
. Zatvorite paletu Properties tako $to éete pritisnuti X u gornjem uglu (X se pojavljuje

u gornjem levom ili desnom uglu, zavisno od toga gde je u prozoru AutoCAD-a
smestena paleta Properties). Takode moZzete pritisnuti desnim tasterom misa
naslov na levoj strani palete Properties i izabrati sa Close iz priru¢nog menija.

. Posto ste zavrsili crtezZ vrata, izaberite File > Close.
. U okviru za dijalog Save Changes izaberite dugme No. (Ranije ste snimili ovu

datoteku, pa sada ne morate ponovo da je snimate.)

Paleta Properties moZe se otvoriti i ako izaberete objekat, a zatim pritisnete desni

taster misa i s menija koji se pojavi izaberete Properties.

Ako zelite da eksperimentisete...

Treba da nacrtate rezu sa slike 2.21.

1.
2.

Pokrenite AutoCAD, otvorite novu datoteku i nazovite je Reza.

1z grafickog editora izaberite komandu Line da biste nacrtali prave delove reze.
Pocnite liniju kako je pokazano na slici, zatim zadajte relativne koordinate preko
tastature. Na primer, za prvi segment linije upiSite @4<1800 da biste nacrtali seg-
ment duZine 4 jedinice, zdesna nalevo.

. Izaberite alatku Arc s palete Draw. Nacrtajte liik za zakrivljeni deo.
. Upotrebite opciju Endpoint Osnap i izaberite krajnju tacku prikazanu na slici da

biste zapoceli lik.

. UpiSite ECl da biste izabrali opciju End komande Arc.
. Ponovo upotrebite Endpoint Osnap i izaberite krajnju tacku iznad mesta na kome

ste zapoceli crtanje linije. Pojavljuje se rastegljiva linija i privremeni lak.

. UpiSite DO da biste zadali opciju Direction komande Arc.
. Postavite kursor tako da istaknuti ltk izgleda kao na slici 2.21. Pritisnite taster

miSa i nacrtajte 1tk.



SLIKA 2.21
Pokusajte da
nacrtate rezu.
Dimenzije su
zadate.

AKO ZELITE DA EKSPERIMENTISETE...

Ovde zapocnite crtanje linije

0

— _ —|— —

4.0

Ovde zapocnite crtanje lika
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